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Introduction

This application note introduces Bluetooth Mesh and its key concepts and describes how to get started with Cypress’
BLE Mesh solution to design your own BLE Mesh-enabled applications. Cypress is a world-leader in connectivity
solutions for Internet of Things (IoT) applications, combining best-in-class silicon platforms with the industry’s most
broadly deployed Bluetooth stack. This combination allows you to deploy successful BLE Mesh-enabled products with
minimum development costs and with a rapid cycle time.

2 More Information
This section provides a list of learning resources for developing Bluetooth Mesh products that can help you to get
started and develop complete applications with Mesh-enabled Cypress EZ-BT™ Modules or silicon products. All
documentation can be accessed at the Cypress Bluetooth Mesh website.
2.1 Mesh-Qualified Silicon Devices
Cypress offers a portfolio of Mesh-qualified Bluetooth devices. Table 1 provides the list of these devices and their
capabilities. For the most up-to-date details on Cypress Mesh-qualified devices, visit the Cypress BLE Mesh Webpage.
Table 1. Mesh-Qualified Bluetooth Device Features
L Bluetooth
Silicon SIG Mesh Flash RAM GPIOs Tx Power | Temperature Software
Device SLEERIEDR s Core | Qualified ey cere (KB) (KB) | (Maximum) (dB) (Degree C) Support
pecification
CYW20706 | BLE/BR/EDR 5.0 Yes 96-MHz CM3 - 352 24 +10 3010+ 85 |\ icED® Studio
. -40 to +105
CYW20719 | BLE/BR/EDR 5.0 Yes 96-MHz CM4 1024 512 40 +4 -30to+85 | WICED Studio
CYW20735 BLE/BR 5.0 Yes 96-MHz CM4 - 384 25 +10 -30to+85 | WICED Studio
CYW20819 | BLE/BR/EDR 5.0 Yes 96-MHz CM4 256 176 40 +4 'jo 10+ 85 | \odusToolbox™
-40 to +105
2.2 Mesh-Qualified EZ-BT Bluetooth Modules

Cypress provides a variety of certified Bluetooth Mesh-Qualified modules to reduce hardware development cost and
time. Every module within the EZ-BT Module family has a unique Marketing Part Number (MPN) used for ordering. The
MPN format is shown in Figure 1.

Figure 1. EZ-BT Module Marketing Part Numbering Format

EZ-BLE Module Part Numbering Decoder
CYBT-F AT T##-N X

| E— Bluetooth Version: 0=BT41,1=BT42 2=BT50
Integration Type: 0 = Full Integration With Shield, 1 = No Shield

Device Identification Number: Unique sequential product number for each module
Temperature Range: 0 = Industrial, 1 = Extended Industrial
EZ-BT Module Type: 3 = WICED Module

0 — No Antenna, Standard Range

1 - PCB Antenna, Standard Range

2 — Chip Antenna, Standard Range

3 — No Antenna, Long Range (internal PA)
Antenna Type: 4 — PCB Antenna, Long Range (internal PA)

5 — Chip Antenna, Long Range (internal FA)

6 — No Antenna, Long Range (external PA/LNA)

7 — PCB Antenna, Long Range (external PA/LNA)

8 — Chip Antenna, Long Range (external PA/LNA)

Flash Size: 0=128KB, 2 = 256KB, 3 = 512KB, 4 = 1024KB
Marketing Code: BT = Dual-Mode BT/LE Product Family
Company 1D: CY = Cypress

Table 2 summarizes the features and capabilities of each EZ-BT Module MPN available from Cypress. Table 2 details
all modules that are sampling or in production. For the latest list of modules available, visit the Cypress Bluetooth
website.
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Table 2. EZ-BT Module MPN Features and Capabilities

e —
2 [} ~
S| 2 5| 8
= = o g = <
»51 8| 9| 8| ¢ il 5| s
=R G @ & « o =3 L‘_E X =
v | B2l 5| 2% = g gl s | |60 ©
. =2 =] 5] < o 8 a = [S)
' Silicon _ = 25 4 9] £ = e o 5 = @ E = a
Marketing Part Number Device Module Size (mm) 214 x O o n I < o O] (%] %) & o o <
CYBT-343026-01 CYW20706 | 14.52x19.2x1.95 | 225 Yes 50 | Yes | Yes Trace 24-SMT | 11 512 | 352 | Yes | No 4 Yes
CYBT-333032-02 CYW20706 12.00 x 13.5x 1.95 250 Yes 5.0 | Yes | Yes | RFPad | 24-SMT 11 512 352 | Yes No 4 Yes
CYBT-343047-02 CYW20706 12.00 x 13.5 x 1.95 250 Yes 50 | Yes | Yes u.FL 24-SMT 11 512 352 | Yes No 4 Yes
CYBT-343151-02 CYW20706 12.00 x 15.5x1.95 400 Yes 5.0 | Yes | Yes Trace 24-SMT 11 512 352 | Yes No 4 Yes
CYBT-353027-02 CYw20707 9.00 x9.00 x 1.75 150 Yes 5.0 | Yes | Yes Chip 19-SMT 8 512 352 | Yes No 0 Yes
CYBT-423028-02 CYW20719 |11.00x 11.00x 1.70 75 Yes 5.0 | Yes | Yes Chip 28-SMT 17 1024 | 512 | Yes | Yes 6 Yes
CYBT-413034-02 CYW20719 | 12.00 x 16.30 x 1.70 75 Yes 5.0 | Yes | Yes Trace 30-SMT 17 1024 | 512 | Yes | Yes 6 Yes
CYBT-483039-02 CYW20719 | 12.75x 18.59 x 1.80 | 10002 Yes 5.0 | Yes | Yes Chip 34-SMT 15 1024 | 512 | Yes | Yes 6 Yes
CYBT-213043-02 CYw?20819 | 12.00 x 16.61 x 1.70 75 Yes 5.0 | Yes | Yes Trace 35-SMT 22 256 176 | Yes | Yes | 6 Yes

2.3

24

25

Mesh-Qualified EZ-BT Module and Silicon Datasheets

EZ-BT WICED Module and silicon datasheets list the features, pinouts, device-level specifications, and fixed-function
peripheral electrical specifications of Cypress module and silicon products. Visit the Cypress BLE and Bluetooth website
to access all datasheets for EZ-BT WICED Modules and silicon devices.

The CYBT-213043-MESH kit referred to in this application note utilizes the CYBT-213043-02 certified module. The
datasheet for this module can be accessed here. This datasheet can also be accessed on the Cypress BLE and
Bluetooth website.

Bluetooth Mesh Evaluation Boards

CYBT-213043-MESH is a Mesh evaluation kit that features the CYBT-213043-02 EZ-BT certified module, based on
the CYW20819 silicon device. This kit includes four Mesh evaluation boards, allowing you to develop a small Mesh
network without the need to purchase multiple evaluation boards. Each board features an Ambient Light Sensor (ALS),
a PIR motion sensor and lens, a thermistor, an RGB LED, a user switch and an on-board programmer (USB-to-UART).
To learn more about the kit and available resources, visit the CYBT-213043-MESH EZ-BT Module Mesh Evaluation Kit
Webpage.

If you are designing Bluetooth Mesh products based on a device or module other than the CYW20819, you can use
the respective device’s evaluation kit. Each EZ-BT WICED Module and silicon device offers a low-cost Arduino-
compatible evaluation board, providing an easy-to-use vehicle to develop and evaluate Bluetooth Mesh using the EZ-BT
WICED Modules and silicon without requiring custom hardware design. Visit the Cypress Bluetooth Mesh website to
view and purchase Cypress evaluation boards.

Cypress Developer Community for Bluetooth Mesh and Technical Support

Whether you're a customer, partner, or a developer interested in designing Bluetooth Mesh products, the Cypress
ModusToolbox Bluetooth Community offers you a place to learn, share, and engage with both Cypress experts and
other embedded engineers around the world. If you have any technical questions, you can post them on Cypress
Developer Community forums that are actively managed by Cypress engineers.

! Measured in meters and is specified as Full Line-of-Sight (LoS) in a Noise-Free environment.

21 km range is certified for US/FCC use only. European and Japan certifications are limited to 10 dBm (600 meters maximum).
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3.1

3.1.1

3.1.2

3.1.3

3.14

BLE Mesh Overview

Bluetooth Low Energy (BLE) has emerged as the preferred standard for IoT connectivity. The BLE standard’s inherent
low-power operation coupled with installed support on smart phones and personal computers have been a driving force
behind its growth in 10T applications.

Traditional BLE applications use point-to-point communication, where each pair of devices sends data to and from each
other. Each of these connections utilizes a GAP Central and a GAP Peripheral role to accomplish the communication.

In contrast, in a Mesh network, every device can communicate with every other device within the same network. This
capability extends the overall communication range beyond the range of each individual device. In a Bluetooth Mesh
implementation, messages are sent using advertising packets. By using advertising packets for network
communication, the relaying of network messages requires no connections to be made to share information. Rather,
data is broadcast by a transmitting device using these advertising packets and is received by any device that is part of
the network and that is within the range of the transmitter. Devices that are provisioned into a BLE Mesh network are
called "nodes". Bluetooth Mesh defines various types of nodes; some utilized for range extension and network coverage
while others are optimized for low-power operation and only wake when they need to.

BLE Mesh is emerging as a preferred home automation technology driven by the fact that BLE Mesh nodes can be
controlled directly from a mobile phone or PC without the need to install a network gateway. The BLE Mesh specification
has been defined to provide standards-based operating models tailored to home and industrial automation use cases.
Standard message formats for defined use cases (models) enable rapid deployment and interoperability assurance
with other BLE Mesh products.

BLE Mesh Nodes and Feature Types

BLE Mesh has several node/feature types. Each node can include multiple features if desired. This section provides
an overview of the different BLE Mesh node types and various features that can be employed on these nodes.

Relay Node

The Relay feature of a node includes the ability to relay messages over the advertising bearer. In a Mesh network,
most nodes include this feature unless they are low-power nodes (LPNs). An example of a Relay feature in use is a
smart light bulb or light switch. Typically, any node that is wall-powered is likely to be a Relay Node as they have the
power needed to listen continuously for advertising packets and relay them to additional nodes in the network.

Low-Power Node (LPN)

A Low-Power Node is a critical feature for BLE Mesh-enabled applications. Low-Power Nodes operate in low duty
cycles, by working and communicating in conjunction with Friend Nodes that collect messages on the LPN’s behalf.
The LPN will ping its Friend node at a defined interval to check for pending messages, and after communication with
the Friend Node, it will go back to a low-power sleep state to conserve power. Any battery powered application, such
as a glass door sensor or smoke detector can be a low-power node. With the BLE Mesh low-power feature, even a
coin-cell battery is often sufficient to power a Low-Power Node for over a year.

Friend Node

A node with the Friend feature will listen to any messages that are relayed in the network and are intended for its
associated LPNs. The Friend node will store these messages and deliver them to the associated LPNs when the LPNs
wake and query the Friend node. Since a Friend Node needs to store messages for one or more LPN, the Friend Node
may require more memory than other node types. The amount of memory required is dependent on the amount of
data/commands required to be stored on the Friend node that will be communicated to the LPNs during a polling
operation.

Proxy Node

BLE Mesh networks relay messages over an advertising bearer. The Proxy feature is the ability of a node to relay
messages between the GATT (General ATTribute) and advertising bearers. This feature allows devices, such as
smartphone, that support BLE but not BLE Mesh, to communicate with a Mesh network. A Proxy Node is the entry
point into the Mesh network for those devices that don’t directly support BLE Mesh. Any node that supports the Proxy
feature can act as the interface for a smartphone/PC over a GATT connection.

WWW.Cypress.com Document Number: 002-27069 Rev. ** 4
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3.15

3.2

3.2.1

3.2.2

Provisioner

The Provisioning feature is a key to enable a secure BLE Mesh network. Provisioning is the process of adding a new
node to a network. When your consumer purchases a BLE Mesh-enabled device, they need to have the ability to add
this device to their network. This requires several steps to ensure that unintended devices are not provisioned to the
network. A device that is unprovisioned will send beacons at a predetermined interval, and the provisioning device will
initiate the provisioning process once the unprovisioned device is found and selected. BLE Mesh uses the Elliptic Curve
Diffie Hellman (ECDH) algorithm to exchange keys for secure communication to ensure that your network and the
provisioning of devices into it is secure.

Figure 2. BLE Mesh Network and Node Types

Relay +
GATT Proxy

Node
b

06
. Smartphone
Relay @

BLE Mesh uses a managed flood operation to transfer messages. Managed flood is inherently a multi-path
implementation that adds enough redundancy to ensure that a message reaches its destination. A brute force flood
implementation is one where every node blindly relays (retransmits) any message that it has received. Conversely,
the BLE managed flood operation is designed to prevent devices from relaying previously received messages by adding
all messages to a cached list. When a message is received, it is checked against the list and ignored if already present.
If the message has not been previously received, then it is added to the cache so that it can be ignored in the future.
Each message includes a Time to Live (TTL) value that limits the number of times a message can be relayed. Each
time a message is received and then relayed (up to a maximum of 126 times) by a device, the TTL value is decremented
by 1.

Relay +
Friend

Low Power

Low Power

BLE Mesh Operation and Key Concepts

Managed Flood

Publish- and Subscription-Based Communication

A Publisher Node sends messages, and only nodes that have subscribed to the Publisher will act on these messages.
This ensures that different types of products can coexist in a network without being bothered by messages from devices
they do not need to listen to. An example of this operation is different rooms within your home, with each room
subscribing to messages related to the specific light switches for that room. In addition, messages can be either unicast,
multicast, and/or broadcast, meaning that a message can reach one, a few, or all nodes in the network.
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3.2.3

3.24

3.24.1

Figure 3. Publish and Subscribe Example

( Publish J

Dining Room Kitchen Bedroom Living Room Backyard
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Elements

Elements consist of entities that define a node’s functionality. Each node can have one or more Elements. Every node
has at least one Element called the “Primary Element”. For example, a dimmable light bulb generally has one Element;
this Element can expose one or more functionalities such as ON/OFF and level (brightness) control. In this example,
the Light Lightness Server Model is used to achieve the ON/OFF and level control functionality.

Another example is a dimmable light bulb that also includes an occupancy sensor. In this example, the node will have
two Elements: one for the lighting function and the other for the sensor function. The Primary Element in this case
would be the lighting function, and the Light Lightness Server Model is used to access the lighting controls. The
secondary element in this example is the sensor, where the occupancy sensor’s states can be accessed. Figure 4
shows a representation of both examples.

Every Element within a node has a unique address, known as a unicast address. This allows each Element to be
addressed independently of other Elements within the same node.

Models

Models are used to define the functionality of a node — they bring together the concepts of states, transitions, bindings,
and messages for an Element. Models are analogous to Services in regular Bluetooth devices. There are three types
of Mesh Models — Client Models, Server Models, and Control models which implement both a Client and Server in a
single model.

Server Model — A Server Model can have one or more states spanning one or more Elements. The Server Model
defines messages a model may transmit and receive. It also defines the Element’'s behaviors based on these
messages. Said another way, Server Models expose the states of the Element that can be read or controlled by a
Client. An example application of the Server Model is a sensor that exposes the sensor’s state or a light bulb that stores
the current state of the light.

Client Model — A Client Model defines the set of messages to request and change the state of a Server. For example,
an ON/OFF Switch (operating as a Client) can send a message to an ON/OFF Server to change the device’s state.

Control Model — An end application can use Server Models or Client Models, or both along with control logic. Any
combination of Server and Client Models results in a Control Model.

Model Hierarchy

Models can (and often do) extend the functionality of other models. That is, models can be hierarchical. For example,
the ‘Light Lightness’ model extends the ‘Generic OnOff Server’ model and the ‘Generic Level Server’ model. What that
means is that if you implement the Light Lightness model in an application, you get all the Light Lightness functionality
plus all the Generic Level and Generic OnOff functionality.

Models that do not extend other models are known as "root models".

WWW.CYpress.com Document Number: 002-27069 Rev. ** 6
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3.25 States and Properties
3.2.5.1 States

Elements can be in various conditions; in Bluetooth Mesh, these conditions are stored in values called states. Each
state is a value of a certain type contained within an element. In addition to the values, states have behaviors that are
associated with that state. States are defined by the Bluetooth SIG.

For example, there is a state called ‘Generic OnOff’ which can have two values — ON or OFF. This is useful for devices
like light bulbs or fan motors. The term ‘Generic’ is used to indicate that this state and its behaviors may be useful in
different kinds of Mesh devices.

3.2.5.2 Properties

Properties also contain values relating to an element; however, unlike states, properties provide the context for
interpreting states. For example, consider a device that wants to send a temperature state value. The temperature state
may be "Present Indoor Ambient Temperature" or "Present Outdoor Ambient Temperature”. In this case, a property
would be used to provide the context for the temperature state value.

Properties can be manufacturer properties, which are read-only or Admin properties, which allow read-write access.
3.2.5.3 State Transitions

State transitions may be instantaneous or may execute over a period called the transition time.
3.2.5.4 State Binding

States may be bound together such that a change in one state causes a change in the other. One state may be bound
to multiple other states. For example, a light controlled by a dimmer switch will have one state called Generic OnOff
and another called Generic Level to specify the brightness. If the light is in the ON state but is dimmed to the point
that the Level becomes zero, then the OnOff state will transition to OFF. State binding is used in the Dimmable Light
Bulb Code Example discussed later in this document.

State binding is defined by the models that contain the states in question. These can be found in the Bluetooth Mesh
Specification.

Figure 4 illustrates the relationship between a Mesh node, elements, models and states.

Figure 4. Relationship Between Mesh Node, Elements, Models and States

Node — Dimmable Bulb Node - Dimmable Bulb with
Occupancy Sensor

Primary Element

Primary Element
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3.3 Security and Privacy in BLE Mesh

Security and privacy are always a concern in wireless-connected devices. BLE Mesh incorporates several techniques to
alleviate this concern. Table 3 details the security and privacy methods implemented in a BLE Mesh solution. To learn
more about BLE security, refer to Bluetooth Mesh security overview at Bluetooth SIG website. To learn more about how
they are implemented, refer to the BLE Mesh Networking Specification.

Table 3. Bluetooth Mesh Security and Privacy

Security / Privacy Feature What does it do?

Encryption and Authentication All Bluetooth mesh messages are encrypted and authenticated.

Separation of Concerns Network security, application security, and device security are addressed independently by means of
separate keys for each.

e An AppKey is used to avoid any conflict of interest and differentiate one application type from
another. For example, a sensor node cannot decode a message encrypted with the lighting
AppKey.

e  Each node possesses one or more NetKeys based on the network and subnets they are part of.
The NetKey separates each network and subnet from all others.

e  Each node has a unique DevKey that is used for provisioning and configuration which separates it
from all other devices.

Area Isolation A Bluetooth Mesh network can be divided into subnets, each cryptographically distinct and secure from
the others. For example, each room in a hotel can be a subnet while the hotel is the complete network.
Subnets allow guests from one room not to interfere with other rooms.

Key Refresh, Trashcan Attack Security keys can be changed during the life of the Bluetooth mesh network via a Key Refresh
Protection, and Node Removal | procedure. When a node is removed from the network, the Mesh network runs the key refresh procedure
to change the keys on all other nodes. Once keys are refreshed, the (old) keys stored on the node that
were removed have no value. This feature addresses security concerns if someone gains access to a
device that was present earlier in a BLE network — this type of attached is known as a trashcan attack.

Replay Attack Protection Bluetooth mesh security protects the network against replay attacks. Replay attacks are one of the most
common attacks in which an eavesdropper listens to a message and then replays it with the bad intent.
Imagine someone listens to a door unlock message and then replays it in the middle of the night to break
into a house. BLE Mesh provides a mechanism to avoid replay attacks by adding a sequence number in
each message. Messages with the same or lower sequence number as a previous message are
automatically ignored.

Message Obfuscation Message obfuscation makes it difficult to track messages sent within the network and, as such, provides
a privacy mechanism to make it difficult to track nodes.

Secure Device Provisioning BLE Mesh provides a secure method to add a device to the network.
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4 Software Development Tools and Helper Applications
Cypress provides easy-to-use tools and Helper Applications to enable evaluation and development of Bluetooth Mesh
products.
1. ModusToolbox
2. i0S helper application
3. Android helper application
4. Windows helper application
4.1 ModusToolbox
ModusToolbox is a free state-of-the-art software development ecosystem that includes the ModusToolbox IDE and
Software Development Kits (SDKs) such as the WICED® BT SDK (hereafter referred to as the BT SDK) and the PSoC
6 SDK to develop applications for Cypress IoT products. ModusToolbox IDE is a multi-platform, Eclipse-based
integrated development environment (IDE) used to create new applications, update application code, change
middleware settings, and program/debug applications.
Using ModusToolbox IDE, you can enable and configure device resources and middleware libraries; write C source
code; and program and debug the device. The IDE provides hooks for launching various tools provided by the BT SDK.
The BT SDK provides the core of the ModusToolbox software for creating Bluetooth LE, Classic, and Mesh applications
with CYW20819 and EZ-BT modules based on it. It contains configuration tools, drivers, libraries, middleware, make
files, as well as various utilities and scripts.
411 Getting Started with ModusToolbox
Visit the ModusToolbox home page to download and install the latest version of ModusToolbox. Refer to the
ModusToolbox Installation Guide document in the Documentation tab of ModusToolbox web page for information on
installing the ModusToolbox software. After installing, launch ModusToolbox and navigate to the following items:
®  Quick Start Guide: Choose Help > ModusToolbox IDE Documentation > Quick Start Guide. This guide gives
you the basics for using ModusToolbox.
= User Guide: The detailed user guide under Help > ModusToolbox IDE Documentation > User Guide.
These documents are also available in the Documentation tab of the ModusToolbox Quick Panel.
4.1.1.1 Installing BT SDK 1.2
To develop Mesh applications, BT SDK 1.2 or later must be used. Once ModusToolbox 1.1 is installed per the directions
provided in Section 4.1.1, add the BT SDK 1.2 with following steps:
1. Download BT SDK 1.2 from ModusToolbox BT SDK community page.
2. Open ModusToolbox and go to Help > Update ModusToolbox SDKs... It will show a pop-up saying “Unable to
find installable SDKs, check your Internet connection.” Click OK.
The ‘Update ModusToolbox’ window appears. On the bottom left hand side, click Install Custom SDK.
4. Browse to the downloaded SDK file and click Open. It will install the new SDK in ModusToolbox 1.1.
41.2 ModusToolbox IDE

The ModusToolbox IDE is based on the Eclipse IDE “Oxygen” version. It uses several plugins, including the Eclipse
C/C++ Development Tools (CDT) plugin. Cypress provides an Eclipse Survival Guide, which provides tips and hints for
how to use the ModusToolbox IDE.

The IDE contains Eclipse-standard menus and toolbars, plus various panes such as the Project Explorer, Code Editor,
and Console as shown in Figure 5. One difference from the standard Eclipse IDE is the “ModusToolbox Perspective.”
This perspective provides the Quick Panel, a News View, and adds tabs to the Project Explorer. In the IDE, the top-
level entity that you ultimately program to a device is called an application. The application consists of one or more
Eclipse projects. The IDE handles all dependencies between the projects automatically. It also provides hooks for
launching various tools provided by the software development kits (SDKSs).
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With the ModusToolbox IDE, you can:

1. Create a new application based on a list of starter applications, filtered by kit or device, or browse the collection of
code examples online.

Configure device resources to build your hardware system design in the workspace.
3. Add software components or middleware.
Develop your application firmware.
Figure 5. ModusToolbox
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For more detailed information on ModusToolbox and how to create an application, see the ModusToolbox IDE User
Guide.

413 SDK for CYW20819

SDKs provide the core of the ModusToolbox software. SDKs make it easier to develop firmware for supported devices
without the need to understand all the intricacies of the device resources. An SDK contains configuration tools, drivers,
libraries, and middleware as well as various utilities, Makefiles, and scripts. CYW20819 and CYW20819-based module
application development is enabled by the BT SDK within ModusToolbox. Important features of the BT SDK are listed
below:

m  Bluetooth Mesh stack
m BT stack and Profile-level APIs for embedded Bluetooth LE and Mesh application development
®  APIs and drivers to access on-chip peripheral blocks such as SPI, UART, and ADC
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= Bluetooth protocols supported include Generic Access Profile (GAP), Generic Attribute Profile (GATT),
Security Manager Protocol (SMP), Radio Frequency Communication protocol (RFCOMM), Service Discovery
Protocol (SDP), and BLE Mesh protocol
m  BLE profile APIs, libraries, and sample applications
m  Support for Over-The-Air (OTA) upgrade
m  SDK API Reference: Choose Help > ModusToolbox APl Reference > WICED API Reference. This HTML
format guide gives you information on the SDK APIs related to the CYW20819 device. The API functions are
logically grouped into components, as shown in Figure 6, for easy navigation and reference.
Figure 6. BT SDK API Reference
wicen WICED® BT SDK v1.2 - API Reference Guide wicen
Main Page Components ‘ Globals ‘ Q- Search
Bluetooth References P
WICED Community Cypress WICED CYW208XX API Reference Guide Documentation
WICED BT SDK Licensing Informatior
Ccﬁpmms S « CYW20819/CYW20820 (aka CYW208XX) API functions are logically grouped into Components.
:mag‘tnfg mmpk‘ ec: aanes ‘:S « API function prototypes are provided in the <Bluetooth Controller>/include folder.
i A pac_ =a enumeratons « Aglobal list of all documented functions is available here.
WICED OTA Firmware Upgrade
WICED trace utils
BLE Host Stack Management
WICED Device Management WIC ED Docu mentation
Application Thread Serialization
Bluetooth « WICED HCI Control Protocol
Memory Management » WICED AMS Library
ANG Library AP » WICED ANCS Library
ANS Library API « WICED H.ID Device Library .
BAC Library API « WICED Firmware Upgrade Library
HRG Library API « WICED Semfre QTA Firmware Upgrade App Note
HRS Library API « WICED Application Buffer Pools App Note
BT « WICED XIP (Execute-In-Place) Application Support Guide
" WICED i Debuggns (o Buco s
Bluetooth Mesh API documentation is available in Components > Bluetooth > BLE Mesh.
414 ModusToolbox Code Examples

ModusToolbox includes several code examples that are a great resource to understand the application code flow and
to kickstart your application development. The following built-in code examples are compatible with the CYBT-213043-
MESH EZ-BT Mesh Evaluation kit:

m  BLE_Mesh_Dimmer
m  BLE Mesh_LightDimmable
m  BLE_Mesh_OnOffSwitch

m  BLE Mesh_SensorTemperature
Many additional code and snip examples are available on GitHub. For more details on these additional code examples,
refer to Section 4.1.5

You can either browse the collection of built-in starter applications during application set up through File > New >
ModusToolbox IDE Application or browse the collection of code examples on Cypress’ GitHub repository. See Figure
7 and Figure 8 for details on selecting and searching for code examples. To learn how to create a project and program
the EZ-BT Mesh evaluation board(s), refer to Sections 8 and 9.
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Figure 7. Mesh Code Examples in ModusToolbox IDE
&

Starter Application

Choose starter code for your CYBT-213043-MESH.

Application Name: | BLE_Mesh_Dimmer

| Enter filter text ‘

BLE_Mesh_Dimmer
BLE_Mesh_LightDimmable
BLE_Mesh_OnOffSwitch

This demo application shows a simple BLE Mesh dimmer device implementation, based on the Generic Level Client model.

BLE_Mesh_SensorTemperature

Import...

(’E‘ < Back Finish Cancel

Figure 8. Searching for Online Code Examples in ModusToolbox IDE

~ B2
ModusToolbox

v Start
“ v ADEL atior
I(P ear nline for Code Examples I

~

v BlinkyLED1_mainapp

415 Additional Code Examples on GitHub

Cypress has many additional code and snip examples that are not included in the BT SDK installation. These additional
code and snip examples can be accessed from the GitHub repository. To access these code examples and snip code,
the developer can either directly click on the GitHub repository link or click the Search Online for Code Examples link
provided in the Quick Panel section of the ModusToolbox IDE. For detailed instructions on how to obtain these
examples and program the board, see Programing GitHub Examples in Section 9.2.

416 Mesh-Related Application Settings

Help topics and resources provided in the previous section cover how to create an application using ModusToolbox

IDE. This section covers Bluetooth Mesh-specific settings available in ModusToolbox IDE that are needed when
designing Bluetooth Mesh applications.

To access these settings, right click on application’s mainapp folder in the Project Explorer window and select
Change Application Settings.
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Figure 9. Accessing Bluetooth Mesh Settings in ModusToolbox

¢ Project Explorer 4 4% Debug !!i Registers 7. Peripherals =0
% BLE_EnvironmentSensing Temperature_mainapp
~ = BLE_Mesh_LightDimmable_mainapp

=l Includes New :
bt_20819A1- Go Into
& GeneratedSo Open in New Window
libraries
& led_control.c @& Change Application Settings..
B led_controlh B ModusToolbox Middleware Selector Ctrl+8
g light_dimmal Copy Ctrl+C
L& wiced_platfo Paste Ctrl+V
" wiced_platio| % Delete Delete
20819_readrr Source >
& design.modu love.
makefile.init Rename... F2
» modus.mk 2 Import..
readme.txt Export...
= Watch_mainapp .
@8 Build ModusToolbox Application Ctrl+5
@& Clean ModusToolbox Application

Build Project
Clean Project
Refresh F5
Close Project

Clnca Linrelatad Draiarts

After selecting the “Change Application Settings” above, the application settings window will appear as shown in Figure
10. The first four fields in this window are generic settings that apply to any CYW20819 application. The remaining
fields are specific to BLE Mesh. All fields shown in Figure 10 are described in this section.

Figure 10. Project Settings Window

M Change Project Se... O x
BT_DEVICE_ADDRESS: Hefault
UART: AUTO
ENABLE_DEBUG: 0 v
MESH_MODELS_ DEBUG_TRACES: O
MESH_CORE_DEBUG_TRACES: ]

MESH_PROVISIONER_DEBUG_TRACES: [
REMOTE_PROVISION_SRV: 0 v

LOW_POWER_NODE: 0 v
@ Cancel

Based on the application requirement, each of these settings can and may be changed.

BT_DEVICE_ADDRESS: This field allows the developer to set either a default Bluetooth device address (random 6-
byte address), or a predefined Static Bluetooth Address. Bluetooth Mesh uses a Random Private Address (RPA) and
the Mesh application code takes care of this for you. Therefore, for Mesh applications, this field should remain
unchanged.

UART: This field allows you to select the UART to download the application. For example, 'COM6' on Windows or
‘/dev/ttyWICED_HCI_UARTO' on Linux or ‘/dev/tty.usbserial-000154' on macOS. By default, the SDK will auto detect
the port. This field is especially useful when multiple boards are connected to a computer and a specific port needs to
be programmed.
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4.2

42.1

ENABLE_DEBUG: To enable hardware debugging, set this option to '1'. To learn more about SWD debugging in
CYW20819 and related modules, refer to the Hardware Debugging for CYW207xx and CYW208xx guide available at
Help > ModusToolbox General Documentation > ModusToolbox Documentation Index > Hardware Debugging
for WICED devices.

MESH_MODELS_DEBUG_TRACES: This box, when checked, turns ON debug traces from the Mesh Models Library.
MESH_CORE_DEBUG_TRACES: This box, when checked, turns ON debug traces from the Mesh Core Library.

MESH_PROVISIONER_DEBUG_TRACES: This box, when checked, turns ON debug traces from the Mesh
Provisioner Library.

Note: All three debug traces help provide insights while debugging any Mesh-related issues. These flags enable traces
in prebuilt Mesh libraries provided by Cypress. However, enabling these debug traces increases the application size
and will limit the flash memory size available for user application code.

REMOTE_PROVISION_SRV: This selection, when set to ‘“1’, enables a device as a Remote Provisioning Server. It
allows the provisioner to provision other nodes through this device if a remote node is not directly reachable to the
Provisioner. This is an in-development feature and is not a part of the Bluetooth SIG Mesh 1.0 specification. This
feature is not supported in the BT SDK version 1.2. Future versions of the BT SDK will enable this feature.

LOW_POWER_NODE: This selection, when set to ‘1’, enables the Low Power Node (LPN) feature on the device.
Setting the value in this field to ‘1’ will define the LOW_POWER_NODE macro, which is used by the application to enable or
disable low-power Mesh operation. Note that not all code examples that are provided in the BT SDK and on GitHub
use the LOW_POWER_NODE application setting to enable low-power operation even though it is a global application
setting. Also note that code examples that do use the LOW_POWER_NODE setting to enable low-power option do not
enable it by default so you must enable it in the application settings if low-power operation is desired for those nodes.

Helper Applications

Cypress provides Helper applications on Android, iOS, and Windows platforms that enable you to perform the following:

m  Create and delete Mesh networks and groups
®  Provision nodes

®  Rename nodes

m  Configure subscriptions

m  Configure publications

m  Publish Get and Set messages for lighting applications, including ON/OFF, level, Lightness, Lightness Hue
Saturation, Lightness Color Temperature, Delta UV

m  Get sensor states

m  Set vendor data for vendor models

m  Perform over-the-air firmware upgrade

m  Reset a node to remove it from the network

In addition to these features, the Windows application provides a trace window that displays details on various activities.

iOS Helper App

The iOS Helper app allows you to use an iOS phone or tablet to act as the Mesh Provisioning Client. Cypress provides
a pre-built application that can directly be installed on an iOS device; in addition, it provides the source code to enable
you to customize the application based on your end product and branding.

See iOS Helper App Installation.

Refer to Section 10 for instructions on how to use the Cypress iOS app and step-by-step details on testing the code
examples covered in this application note.
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4.2.2 Android Helper App

The Android Helper app allows you to use an Android device to act as the Mesh Provisioning Client. Cypress provides
a pre-built application that can directly be installed on an Android device; in addition, it also provides the source code
to enable you to customize the application based on your end product and branding.

OS requirements: Android version 7.1 or later
The Android helper application .apk file is available in the ModusToolbox installation directory at:

<Install Folder>\ModusToolbox_1.1\libraries\bt_20819A1-1.0\components\BT-
SDK\common\apps\snip\mesh\peerapps\Android\src\bin\MeshLightingController.apk

Source code is available at:

<Install Folder>\ModusToolbox_1.1\libraries\bt_20819A1-1.0\components\BT-
SDK\common\apps\snip\mesh\peerapps\Android\src\MeshApp

For the latest version of the Cypress Mesh Android app, download the source code from the GitHub repository.

To install the application on your Android device, copy the .apk file to your device. Then go to the device and browse
to the .apk file from a file browser and tap to install it. Follow the on-screen instructions to install the application.

Refer to Using Android Helper App for instructions on using the Cypress Android app and step-by-step details on testing
the example codes covered in this application note.

4.2.3 Windows Helper Applications
Cypress provides two different Windows Helper applications: MeshClient and ClientControlMesh.

Windows Helper applications are useful while developing Mesh applications as they provide ample details that can be
useful while debugging applications.

The MeshClient and the ClientControlMesh applications provide a sample Windows implementation that show how to
use interfaces exposed by Mesh libraries. MeshClient requires Windows 10 or higher. The MeshClient application uses
the PC’s built-in Bluetooth radio, or an external Bluetooth dongle to communicate with the Bluetooth Mesh network.

The MeshClient application implements all layers of the Mesh stack. The ClientControlMesh application implements
only the application layer. It uses the Mesh Models and Mesh Core libraries residing on an embedded device, requiring
a Cypress device (Mesh or other evaluation board) connected to the PC to act as a Client for Mesh operations. Any of
the Cypress devices that support Bluetooth Mesh can be used for this application irrespective of the device used in the
Mesh nodes. The ClientControlMesh application can be used with any version of Windows operating system. The
Mesh_provision_client snip example must be programmed on a Cypress device so that it can operate as a Client
to a Mesh network in conjunction with the ClientControlMesh application. The mesh_provision_client snip example
can be downloaded from the GitHub repository. For detailed instructions on how to obtain snip examples and program
the board, see Programing GitHub Examples in Section 9.2.

See the MeshClient and ClientControlMesh App User Guide to find the application location, source code location, and
instructions for using these apps. This user guide is also available as part of ModusToolbox installation and can be
accessed from Help > ModusToolbox General Documentation > ModusToolbox Documentation Index.
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5

CYBT-213043-02 EZ-BT Mesh Evaluation Kit

The EZ-BT Mesh Evaluation kit (CYBT-213043-MESH) enables the evaluation of the SIG Mesh functionality using the
EZ-BT Bluetooth 5.0-qualified module CYBT-213043-02. The CYBT-213043-02s EZ-BT module is an integrated, fully-
certified, 12.0 mm x 16.61 mm x 1.70 mm, programmable dual-mode Bluetooth (BLE/BR/EDR) module with BLE Mesh
support.

The CYBT-213043-02 module utilizes the Cypress CYW20819 silicon device. CYW20819 is an ultra-low-power and
highly integrated dual-mode Bluetooth 5.0-qualified device. CYW20819's low-power and integration capability
addresses the requirements of both battery- and wall-powered applications that require BLE Mesh, such as sensor
nodes, locks, lighting, blind controllers, asset tracking, and many more smart home applications.

CYBT-213043-MESH kit contains the following:

m  4x Mesh evaluation boards
m  4x USB-A to micro-B cable

®  1x Quick Start Guide

Figure 11 shows the top view of a BLE Mesh evaluation board and calls out the main components and connections
available on the board. All four boards provided in the CYBT-213043-MESH Evaluation Kit are identical and offer the
same features and functionality. The BLE Mesh evaluation board can be powered via the USB connector located on
the top side of the board or can be optionally powered by a CR2032 coin cell battery using the coin cell battery holder
on the bottom of the evaluation boards (Figure 12).

Figure 11. CYBT-213043-MESH Evaluation Board Top View
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Figure 12. CYBT-213043-MESH Evaluation Board Bottom View

CR2032 Coin Cell Battery Holder (Battery Not Included)
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5.1 CYBT-213043-MESH Board Components

Each of the four EZ-BT Mesh evaluation boards includes several elements as described below.

5.1.1 Active Devices

m  CYBT-213043-02 Module: The CYBT-213043-02 EZ-BT WICED Module is an integrated, fully-certified (FCC,
ISED, CE, and MIC), 12.0 mm x 16.61 mm x 1.70 mm, programmable dual-mode Bluetooth 5.0 module. This
module is mounted to the Mesh evaluation board as shown in Figure 11. CYBT-213043-02 uses Cypress’
CYW20819 silicon device, an ultra-low-power dual-mode Bluetooth 5.0 wireless MCU.

®  USB-t0-UART Serial Chip (U2): A USB-to-UART bridge device from Cypress is provided on the evaluation board
to translate USB communication to UART communication (and vice-versa). For example, when HCI UART
communication is configured to “On” on via SW4, the USB traffic from the host PC is connected to the HClI UART
connections of the CYBT-213043-02 module. Additionally, the Peripheral UART (PUART) communication pins of
the CYBT-213043-02 module are connected to another port of USB-to-UART bridge. This allows PUART
communication to be used for either a user interface (command/control) or to print debug messages. Both UART
(HCI UART and PUART) ports are available concurrently on the BLE Mesh evaluation boards.

m  1-MB external SFLASH (U5): The Mesh evaluation board includes a 1-MB external serial flash device. This flash
utilizes the SPI interface of the CYBT-213043-02 module. Solder pad P10 on the module is connected to MOSI,
P8 is connected to MISO, P2 is connected to SCLK and P15 is connected to CS. This 1 MB flash can be used
either for OTA upgrades or user data storage. The CYW20819 device includes 256 KB of on-chip flash memory.
If your user application exceeds 50% of the available on-chip flash memory, the addition of external serial flash is
provided to maintain OTA capability for complex applications.

Figure 13. External Flash Schematics
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= PIR motion controller (U12): U12 is a low-power motion detector that processes the output of the on-board PIR
sensor. This motion controller device allows the CYBT-213043-02 to remain in low-power mode while it constantly
detects motion in the environment. When motion is detected, the PIR controller will interrupt the module using
module solder pad P5.

Figure 14. PIR Motion Controller and PIR Sensor Schematics
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5.1.2 Switches and LEDs

RESET switch (SW1): SW1 is a tactile switch that is connected directly to the XRES (External Reset) connection
of the CYBT-213043-02 module. Activating (depressing) this switch will reset the EZ-BT WICED Module. This
switch is also used if you need to recover the CYBT-213043-02 module to reprogram it.

RECOVER switch (SW2): SW2 is provided to allow programming of a module that has the standard programming
bootloader and/or application image corrupted or erased. It may also be necessary to allow programming a device
that is in a low-power mode. While the kit has power applied, recovery mode can be entered by holding the SW2
button down and then pressing and releasing SW1 (RESET). SW2 is connected to the module’s HCl UART CTS
line (UART_CTS).

User defined Button (SW3): SW3 is provided as a button that the user can configure as required. The SW3
element is connected to P26 on the CYBT-213043-02 module. The output of SW3 when pressed (activated) is
high. Figure 15 shows the user defined button’s circuit.

Figure 15. User Defined Switch Schematics
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HCI UART switch (SW4): SW4 controls the connection of USB data traffic to the HCI UART connections of the
CYBT-213043-02 module. SW4 is a four-element switch (each element corresponding to one of the 4-wire UART
signals — TX, RX, CTS, RTS) used to connect the HCI UART signals on the CYBT-213043-02 module to a host
PC USB interface. To connect HCI UART signals from the CYBT-213043-02 module to the host PC, simply set
each element of SW4 to the ‘ON’ position. To disconnect HClI UART communication from the CYBT-213043-02
module to the host PC, simply set each of the SW4 elements to the ‘OFF’ position. There is no High-Z configuration
available on the SW4 elements; only On or Off positions. Flow control is supported in hardware on the HClI UART
connection.

O SW4 configuration is recommended to be set to the ‘OFF’ state if you need to use header J1 to connect an
external microcontroller to the HClI UART connection of the CYBT-213043-02 module. Header J1 is provided
as an optional HCI UART interface to the CYBT-213043-02 module.

O SW4 configuration must be set to the ‘ON’ position if you need to program the CYBT-213043-02 module via
a PC USB connection.

RGB LED (D1): RGB LED is provided for user-configured behavior as required. RGB LED is an active LOW
configuration, meaning that when the associated pin (R, G, or B) is pulled LOW, the LED will turn ON. The Red (R)
element on the RGB LED is connected to P6 on the module, the Green (G) element is connected to P3 and the
Blue (B) element is connected to P4.

Note: Typical forward voltage for Green and Blue is 2.65 V and can be as high as 3.1 V. Therefore, the Green and
Blue LED may not work at a power configuration setting of 1.8 V or while using a coin cell battery as the power
source. The Red LED has typical forward voltage 1.8 V and maximum 2.1 V. So, it may not work on some boards
at 1.8 V. If full RGB LED functionality is required in your application, use a 3.3 V or 3.6 V VDD configuration on
jumper J8.

Figure 16. RGB LED Schematics
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D4 and D5: These two LEDs are provided to display programming or USB activity while in progress.
D6: This LED is provided to show that USB power is applied to the Mesh evaluation board.
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5.1.3 Sensors

m  Thermistor (R17): The Mesh evaluation board includes a 10-kQ (resistance at 25 °C) NTC (negative temperature
coefficient) thermistor. The thermistor is used in a typical resistor divider configuration with a 10-kQ resistor at 1%
accuracy (R21). Output of the resistor divider is connected to the CYBT-213043-02 module’s A/D input on solder
pad P11. The thermistor circuit is not excited all the time for the purpose of saving power. This circuit is excited
using the CYBT-213043-02 module’s pin P9. Your application will need to drive this pin High to provide power to
this circuit. As there will be resistive loss in the GPIO driver, the output of P9 is connected to A/D input of the
Cypress module on P14 for excitation voltage measurement via a 0-Q resistor (R16).

Figure 17. Thermistor Schematics

R16 0

output High P9 P14 A/D Input

R17
NCP15XV103E03RC

|l P11 A/D Tnput

R21
10k 1%

m  Ambient Light Sensor (ALS) (U4): U4 is an ambient light sensor that communicates to the Cypress module via
I12C. The SDA line of sensor is connected to the module on P32 and the SCL line is connected on P27. The ALS
sensor also provides an active LOW interrupt to indicate a change in Ambient Light of the environment. This line
is connected to the Cypress module on P29. The 12C address for this sensor is 0x1001 010x.

Figure 18. Ambient Light Sensor (ALS) Schematics
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®  PIR motion sensor (U10): U10 is a Pyroelectric/passive infrared (PIR) motion sensor. This is an analog sensor
and is connected to the PIR motion controller device (U12) on the Mesh evaluation board. The PIR motion controller
is connected to the module and alerts the module whenever motion is detected.

Note: Minimum operating voltage for the PIR sensor controller is 2.5 V. So, it may not work at 1.8 V VDD setting using
J8. Use 3.3 V or 3.6 V setting for reliable operation.

5.14 Connectors and Headers

m  CR2032 coin cell battery holder (BT1): Use a CR2032 coin cell battery (not included with the kit) to power the
Mesh evaluation board.

Note: When operating from of a coin cell battery, the HCI-UART connection switch (SW4) should have all four
elements set to the OFF position (disconnecting the HCI-UART connection). Peripheral UART (PUART) should
also be disabled in the user application code to remove current consumption leakage that will occur between the
on-board USB-to-UART bridge device and the Cypress CYBT-213043-02 EZ-BT module.
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5.1.5

Micro-USB connector (J6): The USB connection on the CYBT-213043-MESH evaluation board provides power
to the evaluation board and also provides communication to the board via USB, which is translated to UART
communication and routed to the HCI UART (depending on the configuration of SW4) and PUART connection on
the CYBT-213043-02 Module on CYBT-213043-Mesh evaluation board.

Power source jumper (J5): Use J5 to select one of the two power sources — coin cell (BT1) or USB power (J6).
Table 4 provides the selection options for J5.

Table 4. J5 Jumper Power Source Selection Options

J5 Jumper Configuration | VDD Voltage Level
Short1 & 2 USB Power (Default)
Short2 & 3 Coin cell

Power voltage jumper (J8): If USB power is configured as the power source in jumper J5, then J8, a 3-pin jumper,
is used to configure the input to the module and on-board peripherals to either 1.8 V, 3.3 V or 3.6 V based on the
user configuration. The power supply input is configured by shorting header positions or leaving them open on J8.
Table 5 details the available power supply options and the associated header position connections required.

Table 5. J8 Header Power Supply Connection Options

J8 Jumper Configuration | VDD Voltage Level

Short 1 & 2 3.3V (Default)

Short2& 3 3.6V
Open1&2&3 1.8V

External HCI UART connection header (J1): The J1 header provides all HCI UART communication lines to the
user. This allows you to connect the CYBT-213043-02 Module to a host controller directly without having to connect
through USB. The J1 direct HCI UART connection bypasses the SW4 (HCI UART to USB-to-UART bridge to Host
PC) configuration. It is recommended that SW4 elements 1 ~ 4 are placed in the OFF position if the J1 direct HCI
UART connection is used.

Power consumption measurement header (J2): J2 is provided to allow for power consumption measurement
with a multimeter or current measurement probe.

External connection header (J4): J4 header provides access to 5V_VBUS (USB power) on the Mesh evaluation
board. Additionally, J4 provides access to several module connections, including GND, VDD, HOST_WAKE,
DEV_WAKE, XRES, P12 and P13. To use Hardware debug on the Mesh evaluation board, P12, P13 along with
the GND connection on the J4 header can be used to connect to an external SWD debugger to the board.

GND test point (J9): J9 test point provides access to GND on the Mesh evaluation board that can be used either
for probing or connecting an external power source.

VDD test point (J7): J7 test point provides access to VDD on the Mesh evaluation board that can be used either
for probing or connecting an external power source.

Programming the CYBT-213043-Mesh Evaluation Board

See Section 9 for information on how to program the BLE Mesh evaluation boards.
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6 Bluetooth Mesh Development Setup

Figure 19 shows the hardware and software required for evaluating a Bluetooth Mesh design. CYBT-213043-MESH
evaluation boards have a CYBT-213043-02 module that can talk to other Mesh boards/modules over an advertisement
bearer and any of these boards can talk to a mobile phone running iOS or Android or even a PC running Windows 10.
A Mesh device that talks directly to a PC or mobile phone is called a Proxy node. Communication between a Proxy
node and a mobile phone/PC is over a GATT bearer; the Proxy then relays the information to/from the Mesh network

over the Advertisement bearer. Each board needs to be programmed for the required Mesh functionality using
ModusToolbox to work in a Mesh network.

Figure 19. Bluetooth Mesh Evaluation Setup With iOS/Android/Windows 10-based Devices with MeshClient Application
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If you are using the Windows ClientControlMesh application, one CYBT-213043-MESH board must be programmed as
the Mesh Provisioning Client, because the ClientControlMesh Helper Application does not use the inbuilt Bluetooth
communication on the Windows PC. Figure 20 shows the setup while using the ClientControlMesh application.

Figure 20. Bluetooth Mesh Evaluation Setup for Windows 10-based Devices Using ClientControlMesh Application
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The Testing the Code Examples section of this application note will walk you through the steps on how create and test
your Mesh network.
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7 Cypress Bluetooth SIG Mesh Architecture Overview

This section describes the following details of the Cypress Mesh solution:
1. Overview of the Cypress Mesh implementation. Jump to Section 7.1
2. Understand the User Application Code Flow. Jump to Section 7.2

Within this section, the term “user application code” refers to the application code developed by you, the user, to define
your specific Mesh application (i.e., this term does not refer to Cypress pre-built libraries). This code is analogous to
the code that will be walked through in Section 8.

If you are already familiar with the Cypress Mesh architecture, libraries, and application code flow, you can skip to
Section 8 to walk through how to design Mesh applications.

For additional details on the Cypress Mesh Application library, see Understanding the Flow of the Cypress Mesh
Application Library in the appendix.

7.1 Cypress Mesh Implementation

Figure 21 shows the Bluetooth SIG Mesh architecture implemented in the BT-SDK. The Mesh Core library, Mesh
Models library and Mesh App Library implementation does all the heavy lifting to be interoperable with a Bluetooth SIG
Mesh network. The Mesh user application, as covered in code examples, just needs to define the Mesh configuration,
hardware-specific configuration, and take necessary action when callbacks are received from Mesh app and Mesh
model libraries. The BT-SDK also allows the developer to create vendor-specific Mesh models using the Mesh Vendor
Model library. The Mesh Provisioner Library and Provisioner application help to implement a provisioner that creates a
Mesh network, and provisions and configures new devices.

The following subsections provide details on each library.

Figure 21. Cypress Bluetooth SIG Mesh Architecture
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7.1.1 Mesh User Application Code

The Mesh User Application code (code example or user application code) does not contain a Mesh-specific logic
implementation. The Mesh User Application is the actual user application that defines the hardware actions and
provides the methods for the application to exchange messages with other devices in the network. Cypress provides a
number of Mesh code examples as part of BT-SDK as well as on GitHub for evaluating the Mesh functionality and to
serve as a basis for your Mesh application development. Each code example provides a simple way to realize a specific
functionality.

BT-SDK and GitHub code examples can be put in two different buckets:
7.1.1.1 Server or Client Mesh Code Examples

Server code examples leverage Mesh Server models. These code examples expose the states of the device to a Mesh
Client. For example, the Dimmable Light code example uses the Light Lightness Server model and exposes the Server
Model’s states to a Client. Based on messages received from the Client, the application code in the Dimmable Light
example modifies the LED state.

Client code examples leverage the Mesh Client models. Mesh Client code examples send commands to the network
to change or read one or more Sever node’s states. For example, the Dimmer code example uses the Generic Level
Client Model to change the level in the Dimmable Light example. The application code for the Dimmer example monitors
the user button state and accordingly sends a set command message to the Mesh network.
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7.1.1.2 Provisioner Mesh Code Example

The Mesh Provisioner application code example uses the Mesh Provisioner library to create a Mesh network, and to
provision and configure Mesh nodes. To enable the features of this code example, connect the evaluation board
programmed with the Provisioner Mesh code example to the PC. Use ClientControlMesh Windows application on the
PC to create a Mesh network, provision Mesh devices, and control Mesh nodes.

7.1.2 Mesh Application Library

The Mesh Application library does not implement any core Mesh functionality. It can be considered as a subset of the
application layer with a Mesh Application code example as its counterpart. This library implements state machines and
event handlers for common BLE Mesh functionality. The Mesh Application library abstracts the complexity for the user
application code. It provides callback functions to the Mesh Application code (user application) to allow the user to
implement hardware-level and application-based functionality. The Mesh Application library takes care of initializing the
Mesh Core libraries and registers appropriate callback functions. Most application settings and interactions with the
Mesh Core library are taken care of by the Mesh Application library.

7.1.3 Mesh Models Library and Vendor Model Library

The Mesh Models Library contains the implementation of all standard models defined in the Mesh Models specification.
The library keeps the information about device states and provides a logical interface for the Mesh Application and
Mesh Application library to control or send the status information to the peer device. It translates the inputs from the
Mesh Application and converts them into appropriate Mesh messages. The Mesh Models library receives, parses, and
validates the messages received over the air and sends appropriate events to the Mesh application.

The developer has an option to provide vendor-specific models not defined by the Mesh Models specification. In that
case, Vendor-Specific Models will access the Mesh Core library interface directly. The interface between the application
and the Mesh Vendor Model library is implementation-specific.

7.1.4 Mesh Provisioner Library

The Mesh Provisioner library contains the implementation of a provisioner as defined by the BLE Mesh Networking
Specification. The Mesh Provisioner application code examples access the Mesh Provisioner library to create a new
network, and to provision and configure Mesh devices.

7.15 Mesh Core Library

The Mesh Core library implements the core Mesh functionality from the Bluetooth Mesh profile as defined in the BLE
Mesh Networking Specification and provides communication between devices in a Bluetooth Mesh network. The
Provisioner assigns the device address and provides the security keys to the device. On the device side, everything is
managed by the Mesh Core library. When the Mesh application code receives a callback to perform an action, the
message is already validated to have the required permissions and the data is already decrypted by the Mesh Core
library. Similarly, when the Mesh application needs to send the data out, the Mesh Core library encrypts the message
with the keys provided during provisioning and sends it over the Bluetooth interface.

7.2 User Application Code Flow

The Mesh Application Library takes care of the interaction with the Mesh Models library and the Mesh Core library. The
Mesh Application library sends relevant events and callback functions to the user application code to implement the
application and hardware-specific functionality. Additional details on the Mesh Application Library can be found in
Understanding the Flow of the Cypress Mesh Application Library.

The user application code is a specific implementation for every application for the following reasons:

m  Each user application code needs its own Mesh Core configuration; for example, features supported by the Mesh
device (Friend, Relay, LPN, etc.) along with the parameters of each supported Mesh feature.

m  Each user application code needs its own Mesh element configuration; for example, a Dimmable Light Bulb needs
an element with the BLE MESH LIGHT LIGHTNESS SERVER model.

m  Each user application code needs to register its own callback functions with the Mesh Application library; for
example, the Dimmer Switch application needs to register the hardware initialization function in the
wiced_bt_mesh_app_func_table_t structure to configure a button GPIO based on the hardware schematic.
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m  Each user application code must implement the callback functions registered in the previous step based on the
product requirements.

m  Each user application code needs to implement the functions to control the element(s) of the Mesh device based
on the messages received from the Mesh Model library. For example, a Dimmable Light Bulb device must control
the intensity of the LED by modifying the PWM parameters based on the messages received from the Mesh Models
library.

The typical flow of the user application code is broadly divided in to five steps as shown in Figure 22.

Figure 22. Typical Mesh User Application Code Flow
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Stepl: Define the parameters for Mesh Core Configuration structure,
wiced_bt_mesh_config_t

Step2: Define the parameters for Mesh Core Element Configuration structure,
wiced_bt_mesh_core_config_element_t

Step3: Define the necessary application functions in
wiced_bt_mesh_app_func_table_t

Step4: Implement the callback functions defined in structure,
wiced_bt_mesh_app_func_table_t

Step5: Implement registered Mesh Model Callback functions and implement
the desired user functionality

Before we get into the details of the steps that are part of developing the Mesh user application code, let us get familiar
with the configuration variables that are needed for a Mesh device. Figure 23 illustrates how the different variables
interact with each other to configure the mesh device. The following section provides details regarding each parameter
that is part of Figure 23.

Figure 23. Typical Mesh Device Configuration Variables
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